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Preface

This publication is for customers who are installing and operating the Virtual Operator 
Panel (VOP) with an encryption-capable LTO tape drive or a T-series tape drive that is 
not monitored by a Service Delivery Platform (SDP). 

Note – When an SDP is installed on site and monitoring installed drives with an 
Ethernet private network, the drive Ethernet port is 100% dedicated to the SDP. 
Therefore, the drive Ethernet port is unavailable for the customer connection that is 
required for VOP to interface with the drive. 

Related Documentation
The following list contains the names and part numbers of publications that provide 
additional information that might be needed to use the VOP successfully.

Document Title Part Number

T10000 Tape Drive Operator’s Guide 96174

T10000A Encrypting Tape Drive Security Policy 316055001

T10000B Encrypting Tape Drive Security Policy 316055101

T9x40 Tape Drive User’s Reference Manual 95739

Crypto Key Management Station Configuration and Startup Guide 96261

Crypto Key Management Station User’s Guide 96262

Crypto Key Management System (KMS), Administration Guide 316195102

Crypto Key Management System Version 2.0, Installation and Service Manual 316194904
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Documentation, Support, and Training

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and 
suggestions. Submit your comments by clicking the Feedback[+] link at: 

http://docs.sun.com 

Please include the title and part number of your document with your feedback: 

VOP Customer User’s Guide, 96179 

Sun Function URL

Documentation http://www.sun.com/documentation/ 

Support http://www.sun.com/support/

Training http://www.sun.com/training/

http://docs.sun.com
http://www.sun.com/documentation/
http://www.sun.com/training/
http://www.sun.com/support/
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What’s New

The changes to the VOP application since the previous edition of this guide are detailed 
below:

TABLE P-1 VOP Change Summary

Version Number Description of Changes

1.0.13 ■ T10000A/B and T9840D drives:
■ Changed Make Tape behavior to continue making tapes until the user 

explicitly cancels the operation
■ Fixed enroll bugs
■ IPv6 support

■ T9840D - fixed View Event Log bug

1.0.14 ■ HP encrypting LTO-4 support of the Release 2 specification
■ IPv6 support
■ Added Enroll tab
■ Renamed Diagnose tab to Service tab

■ IBM encrypting LTO-4 support of the Release 2 specification
■ Get Logs for Support menu item

1.0.15 ■ Added new initializing states for encrypting IBM LTO-4
■ DPKM support
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CHAPTER 1

Virtual Operator Panel Overview

Introduction
The Virtual Operator Panel (VOP) facilitates user communication with a T10000 tape 
drive, a T9840D tape drive, or a Linear Tape Open (LTO) Ultrium generation 4 tape 
drive. The VOP provides an intuitive and user-friendly Graphical User Interface (GUI) 
to display drive-related information, to configure the drive, or to perform various drive 
operations and functions. There are two versions of the VOP: T-series (supports 
T10000A, T10000B, and T9840D tape drives) and LTO-4. 

FIGURE 1-1 depicts the T-series VOP (Windows OS) after connection to a drive. 

FIGURE 1-1 T-series VOP Application Window  

1. Menu bar 
2. Drive IP/name 
3. Primary drive message window 

4. Secondary drive message window 
5. VOP message pane 
6. Drive status indicators 
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Note – VOP on the Linux or UNIX OS is similar but with a Linux/UNIX look and feel 
(see the following figure). 

T-series VOP Application Window
The application window in FIGURE 1-1 contains the following sections:

■ The menu bar contains the names of the online and offline menus. The File and Help 
menus are the only available menus before you complete a drive connection. The 
Drive Operations, Retrieve, and Configure menus have sub-menus and commands 
that are available after VOP connects to a drive. Note that you must place the drive 
offline to access the Configure menu.

Note – See Chapter 4, “VOP Operation - T-series Tape Drives” for details about VOP 
menus.

■ The drive name area displays the drive name or IP address (10.0.0.1 in this example). 

■ The primary and secondary drive message windows show drive status, host-
generated messages, error messages, and so on. 

■ The VOP text message pane displays the VOP transcript.

■ The drive status indicators show drive conditions (see TABLE 1-1).
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Note – See Chapter 4, “VOP Operation - T-series Tape Drives” for additional 
information.

TABLE 1-1 Drive Status Indicators  

Indicator Color Meaning

All Black Indicates no connection to a tape drive.

Loaded 
Unload 
 
 
Empty

Blue 
Grey 
 
Magenta 
Grey

Indicates that a cartridge is loaded in the drive. 
Indicates that a cartridge is present in the loading slot,  
but NOT loaded in the drive. 
Indicates cartridge loading/unloading is in transition. 
Indicates that a cartridge is NOT present in the loading slot.

Online 
Offline

Blue 
Grey 
Magenta

Indicates that the drive is online (label reads Online). 
Indicates that the drive is offline (label reads Offline). 
Indicates online/offline is in transition.

Clean Orange Indicates that the drive needs to be cleaned. 

Dump Orange Indicates that there is a dump present for retrieval. 

Encryption 1 Red Indicates that the drive is encryption-enabled and has all keys (label is Enabled).

Orange Indicates the drive is either missing an encryption key (label indicates Media for 
KMS 2.0) or has not been enrolled (label indicates No Ecpt for KMS 2.0).

1. The encryption status indicator is present only with an encryption-capable drive.
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LTO-4 VOP Application Window
The Ultrium LTO-4 VOP (Windows OS) is shown in FIGURE 1-2 after connection to a 
drive. The main parts of the window are:

■ Title bar 
■ Connect button 
■ Four drive status indicators: Online, Empty, Service, and Encrypt 

Note – The Online and Empty indicators are in a different order than those of the  
T-series VOP.

■ Four information panels (tabs): Monitor Drive, Enroll Drive, Configure Drive, and 
Service Drive. 

Note – VOP on Linux or UNIX OS is similar but with a Linux/UNIX look and feel.

FIGURE 1-2 LTO-4 VOP Application Window 
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Whereas the T-series VOP GUI has several menus, the only true menu in the LTO VOP 
GUI appears when you click on the logo in the upper left corner of the title bar (see the 
figure below). You will use the tabs in the main body of the window to complete 
various enrollment, configuration, and drive service tasks or to monitor the drive (see 
Chapter 5, “VOP Operation - LTO”).

Prerequisites 
Before you can install and operate the VOP application, your system must meet certain 
prerequisites. 

Operating System Requirement 
The following operating systems are certified for VOP: 

■ Linux–Redhat 9.0, ES 
■ Solaris–SunOS 5.8, SunOS 5.9, and SunOS 5.10
■ Windows 2000 or XP 

Note – It is unlikely that platforms with older operating systems meet the minimum 
hardware requirements (see “Computer Hardware Requirements” on page 24).

FIGURE 1-3 Window Control Menu - LTO VOP
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Computer Hardware Requirements 
■ 512 MB memory 
■ 1.0 GHz processor 
■ Monitor screen resolution 1024 x 768 (minimum)
■ Ethernet port available for static IP addressing
■ RJ45-RJ45 Ethernet cross-over cable (direct connection to a drive or drive tray) 
■ RJ45-RJ45 Ethernet cables (indirect connection through an Ethernet switch)

Note – See Appendix B for indirect Ethernet connection guidelines.

The picture below shows an LTO drive tray for the SL3000 modular library system. 
Notice the Ethernet port in the lower left corner of the LTO encryption-capable drive 
tray. Above the Ethernet port is the STATUS indicator and an IP RESET switch. The 
T9840D and T10000 tape drives have similar items but they might be located differently 
on the drive tray.

Your computer must be configured with a static IP address that is compatible with the 
target drive. 

FIGURE 1-4 Drive Tray Ethernet Port
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Note – See Appendix A, “Changing the Computer IPv4 Address” for guidelines.

When you have Ethernet connection to a drive and a compatible static IP on your 
computer, you are ready to operate VOP.

Java™ Runtime Environment Requirement 
The VOP software application is a Java-based program. Therefore, you need a 
compatible version of Java Runtime Environment (JRE™) installed on your computer. 

Note – Your computer must have version JRE 1.5, or higher, to properly install and run 
VOP release 1.0.10, or higher.

Before attempting to install and run VOP, verify the presence, and release level of JRE. 
On Windows OS, open the Control Panel, and double-click Add and Remove Programs.  
On Linux/UNIX OS, see your system administrator.
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CHAPTER

 

2

Software Installation

This chapter provides instructions to install/update the Java Runtime Environment 
(JRE) and the customer (system administrator) version of the Virtual Operator Panel 
(VOP). 

Install the Java Runtime Environment 
To install/update Java Runtime Environment, go to http://www.sun.com.

Note – The Sun web pages are dynamic and subject to frequent changes. Therefore, the 
actual pages you see might differ from the examples in this section (FIGURE 2-1 through 
FIGURE 2-2 on page 29). 

Tip – Read the prompt text carefully before making selections.

1. Choose Java 2 Standard Edition from the Downloads menu.

A page containing all available Java SE downloads opens.

FIGURE 2-1 Sun Home Page

www.sun.com
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2. Make sure to select the Latest Release tab. 

Note – The list of the latest release of Java SE downloads is rather long; therefore, all 
but the Java Runtime Environment has been removed from the image. 

3. Click Download to start the JRE download.

A screen containing the License Agreement and a list of available platform versions 
appears.

Note – You must Accept the License Agreement to download any selection. 

4. Accept the license agreement.
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5. Select the check box that matches your processing platform, then click the adjacent 
link.

Note – There are more platform selections than are shown in FIGURE 2-2. Review the 
complete list before you make a selection.

If you select offline installation, you are prompted to specify the location for the large 
executable installation file. You can then exit the Sun web page.

If you select online installation, a small installer executable file is saved to your 
desktop. You should remain online to the Sun web page until the installation finishes.

6. Double-click the executable file to start the installation process.

The installation process takes several minutes, and requires your response to some 
prompts. 

After the installation completes, you are ready to install and run the VOP. 

Note – The JRE installation/update does not remove old JRE versions. However, their 
continued presence is ignored. Use discretion about removing older JRE versions.

7. (Optional) Exit from the Sun web page if you used the online installation method.

8. (Optional) Delete the file you used to install the JRE version.

FIGURE 2-2 Platform Version Selection
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VOP Application Software 
The VOP application software installation process consists of four parts:

■ Downloading the latest VOP version (zip file)
■ Extracting (unpacking) the zipped (compressed) contents
■ Installing and launching VOP (Windows OS or Linux/UNIX)
■ Performing post-installation options

▼ To Download a VOP Zip File 
Begin the VOP installation process by downloading the latest VOP version release level 
zip file from the designated download resource.

1. Create a local sub-folder for the VOP download.

Create the folder as a direct subordinate to the root (home folder in Linux/UNIX) and 
naming it “VOP_download” or another name of your choice.

2. Download the latest version of the program from the Sun Download Center.

Tip – Use the following URL: http://www.sun.com/download/.

a. Click the Downloads A-Z tab.

b. Scroll through the S section to locate StorageTek Virtual Operator Panel (VOP).

The example below shows the StorageTek Virtual Operator Panel (VOP) v1.0.14 - 
Tape Drive Mcode link.

c. Click the VOP link, read and agree to the license agreement, and enter your user 
name and password.

d. Click the Log In and Continue button.

3. Save the VOP zip file to the folder created in Step 1.

After the VOP zip file is saved to your local disk, you can exit from the web page.

4. Install VOP on your processing platform, see:

“VOP Installation, Windows OS Computers” on page 31.

“VOP Installation, Linux/UNIX OS Computers” on page 41.

www.sun.com/download/
http://www.sun.com/download/
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VOP Installation, Windows OS Computers 
VOP software installation consists of the following activities:

■ Extracting (unpacking) the zipped (compressed) file contents
■ Installing the software
■ Launching each VOP program
■ Verifying version levels
■ Performing post-installation options

Note – VOP version 1.0.14 is used as a representative example of the installation 
process. The primary installation differences between VOP versions are filenames, the 
actual installation program, and the quickstart links and desktop shortcuts created by 
the installation program.

▼ To Extract VOP Files, Windows OS
There are several methods of extracting the VOP folders/files from the zip file. The 
following example is modeled on the Windows XP operating system and the IZArc 
utility. The following procedure uses the most direct method to extract the VOP files 
within the download folder.

1. Open the sub-folder that you created in Step 1 of “To Download a VOP Zip File” on 
page 30.

2. Right click on the zip file. 

A menu appears, similar to the image below. 
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3. Choose IZArc > Extract to here.

The VOP files are extracted into the current folder.

Note – The zip file contents will vary relative to the specific VOP version.

The example above shows four install files, each one for a different host (Linux-x86, 
Solaris-SPARC, Solaris-x86, and Windows). Each file is executable.

▼ To Perform an Installation for the Windows OS
The automatic setup process installs VOP program files within the Windows Program 
Files structure, and creates a Start Menu path for launching the program.

1. Double-click the executable (.exe) Windows file.

An information dialog box appears.
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2. Click the Yes button to continue.

The installation wizard window appears. 

3. Click the Next button and accept the license agreement. 

4. Specify the directory for the wizard to install the VOP files. 

5. Click the Next button to continue. 

The copy files screen appears.
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6. Click the Next button to continue. 

Installation progress information appears on the screen.

7. Click Finish on the Wizard Complete screen. 

Note – The number of desktop and Quickstart shortcuts can vary from one VOP 
release to the next.

The VOP program launches.
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8. Exit the program.

Tip – Click the “X” in the upper right corner, use the Exit command in the File menu or 
use the shortcut keys (ALT+F to open the file menu and SHIFT+E to exit). 

▼ To Test Launch the ltoVOP Program, Windows
The ltoVOP program is available in VOP 1.0.12 or higher. The following example uses 
the ltoVOP.bat file to launch the program. Other methods are usually available to 
launch the program.

1. Open the VOP folder.

2. Double-click the ltoVOP.bat file.
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The LTO-4 Virtual Operator Panel window opens. 

Note – The VOP version number appears near the center of the GUI title bar.

3. Exit from the ltoVOP program.

Tip – Click the “X” in the upper right corner of the window.

▼ To Determine the sunVOP/Java Version, Windows
Use the About command in the Help menu to verify the VOP version and Java version.

1. Click Start, elect the All Programs > VOP program folder, and select the VOP 
executable file. 

Note – The installation process for certain versions of VOP provides a quick start for 
LTOVOP. Make sure to select the VOP option if multiple options are present.
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The VOP application window opens. 

Note – There is a noticeable delay when you open the VOP application for the first 
time of every PC power-on session due to the anti-virus scan. 

Tip – Connection In Progress appears in the two drive message windows, but the 
application is open without actually initiating a drive connection. Notice that the Drive 
Name is NONE and all status indicators are black.

2. Choose About from the Help menu.

The Drive About Dialog box opens.

3. Confirm the release levels in the VOP Version and the Java Version fields.

If either of the release levels is not correct, replace it with the proper level.

Note – Java version 1.5, or higher, is required when using a VOP version greater than 
1.0.9. 

4. Click the OK button or use the ALT+O shortcut keys to close the About dialog box.
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5. Exit the program.

Tip – Use the File menu or click the “X” in the upper right corner. 

VOP Post-Installation Options, Windows
When you have confirmed the VOP programs open and the release levels are correct, 
you can optionally delete down-level versions or unneeded VOP folders or files. You 
should delete or empty the VOP download folder that was created to temporarily hold 
the VOP download.

▼ (Optional) To Delete Unneeded Windows Folders or Files 

Note – After you have confirmed the newest version of the VOP programs are fully 
functional, it is considered best practice to remove/delete unneeded VOP folders. 

The following procedure removes/deletes unneeded VOP program files: 

1. Remove the down-level VOP program folders/files:

a. Open the Control Panel, Add or Remove Programs utility.

The VOP versions are listed.
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b. Select the down-level VOP program.

Once you make the selection (VOP_Rel_1_0_8_Customer in the previous image), the 
Add or Remove Program window changes, as shown below.

c. Click Change/Remove to start the removal process.

An alert box appears. 

d. Click either Yes to confirm or No to cancel.

After the old VOP is removed, a confirmation notice appears.

e. Click OK, close the Add or Remove Program window, and close the Control Panel.
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2. Delete the VOP_download folder:

a. Open the root folder.

The VOP_download folder you created to hold and extract (unzip) the VOP program 
folders and files is listed. 

b. Right-click the VOP_download folder and choose Delete.

The Confirm Folder Delete dialog box appears. 

c. Click Yes to confirm or No to cancel.

After the VOP_download folder is deleted, it no longer appears in the folder tree.
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VOP Installation, Linux/UNIX OS Computers 
This section contains instructions to install the VOP software on computers with Linux 
or UNIX operating systems. The installation consists of three parts: extract/unzip VOP 
files, install VOP, and post-installation options.

Note – There are multiple ways to accomplish the same task. The following procedures 
are modeled, using Solaris 10. 

VOP version 1.0.14 is used as a representative example of the installation process.

▼ To Extract VOP Folders/Files (Linux/UNIX)
Use the following procedure to extract the zipped VOP files:

1. Launch File Browser.

2. Navigate to the sub-folder that you created in Step 1 of “To Download a VOP Zip 
File” on page 30.

3. Click and hold the right mouse button over the VOP zip file.

A list of commands appears.

4. Select Extract Here. 

The utility extracts the zipped contents behind the scene.

5. Click Reload in the tool bar.

The screen refreshes and shows the extracted files. 

Note – The example above shows four install files, each one for a different host (Linux-
x86, Solaris-SPARC, Solaris-x86, and Windows). Each file is executable.
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▼ To Perform an Installation (Linux/UNIX)
The manual installation of the VOP program consists of the following parts: 

■ Installing VOP
■ Launching a program

■ sunVOP
■ ltoVOP (appears in version 1.0.12 or higher)

■ Deleting Windows files

1. Make sure the Java JRE and the VOP/bin folder locations are in the search path on 
the computer. 

If required, use Linux/UNIX utilities to specify their locations. This requires that you 
change the $PATH variable in the “.cshrc” file to include the java/bin directory. In the 
CLASSPATH file, add the path to the java directory.

Note – If this installation is to update an earlier VOP version, you must rename the 
existing VOP folder. If there is not an existing VOP folder, skip to step 3.

2. (Optional) Rename an existing VOP folder as VOP_old.

3. Double-click the appropriate executable install file in the VOP_download folder.

An information dialog box appears.



 

VOP Application Software

96179 • Revision JB  Chapter 2 Software Installation 43

4. Click the Yes button to continue.

The installation wizard window appears. 

5. Click the Next button and accept the license agreement. 

6. Define the directory for the wizard to install the VOP files. 

Note – The default directory is /usr/local/VOP.

7. Click the Next button to continue. 

The copy files screen appears.
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8. Click the Next button to continue. 

Installation progress information appears on the screen.

9. Click Finish on the Wizard Complete screen. 
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10. Close the sunVOP program. 

Tip – Click the “X” in the upper corner of the program window, choose Exit from the 
File menu, or use shortcut keys (ALT+F to open the file menu and SHIFT+E to exit).

11. Verify the new location and contents of the new VOP sub-folder.

Note – You should see a few sub-folders (such as: bin, icons, and lib) and some files. 

12. Delete the Windows only files.

You do not need the ltoVOP.bat and sunVOP.bat files for the Linux/UNIX setup. The 
sunVOP file (no extension) and the ltoVOP are the Linux/UNIX executable files. 
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▼ To Test Launch ltoVOP (Linux/UNIX)
The ltoVOP file is available in VOP releases above 1.0.11.

1. Double-click the ltoVOP file.

2. The Run or Display? dialog box appears. 

3. Click Run.

The VOP application launches, and the VOP application window opens. 

4. Close the application window.

Tip – Click the “X” in the upper right corner of the window.
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▼ To Determine the sunVOP and Java Versions 
(Linux/UNIX)

1. Double-click the sunVOP file.

2. The Run or Display? dialog box appears. 

3. Click Run

The VOP application launches, and the VOP application window opens. 

Note – Connection In Progress appears in the two drive message windows, but the 
application is open without a drive connection actually being initiated. Notice that the 
Drive Name is NONE.
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4. Choose About from the Help menu.

The Drive About Dialog box appears. 

5. Verify the release levels listed in the VOP Version and the Java Version fields.

If the VOP release level is not correct, replace it with the proper level. If the Java 
version is not correct, contact your system administrator.

Note – Java version 1.5, or higher, is required when you use VOP version 1.0.10 or 
higher. 

6. Close the Drive About Dialog box.

Tip – Click the OK button or use the ALT+O shortcut keys.

7. Exit the program.

Tip – Use the File menu or click the “X” in the upper right corner. 

The VOP application window closes.
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VOP Post-Installation, Linux/UNIX OS
When you are satisfied that the newly installed VOP program is functioning properly, 
you can delete down level VOP folders/files.

▼ (Optional) To Delete/Remove Folders/Files, Linux/UNIX

Note – Although it is not necessary to remove unneeded VOP folders, it is considered 
best practice to do so, once the newest version is fully functional. Even if the newest 
version becomes dysfunctional later, you can redownload, and reinstall the current 
version.

Use normal Linux/UNIX commands to delete unneeded VOP program files:

1. Delete the down-level VOP_old directory/folder.

This folder was replaced by the update for VOP.

2. Delete the VOP_download directory/folder

This folder was temporary to hold and extract the updated VOP folders/files, and is no 
longer needed.
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3

Starting VOP Programs

This chapter assumes that the Virtual Operator Panel (VOP) operates with an Ethernet 
connection to a single tape drive. See Appendix B for additional guidelines when 
operating VOP within a multiple-drive private network.

For basic hardware requirements and a description of the drive connection, see 
“Computer Hardware Requirements” on page 24.

Early versions of the VOP application provided an operator panel for only the T10000A 
tape drive. Now it provides an operator panel for other T-series tape drives (T10000A, 
T10000B, and T9840D) and also enables encryption enrollment of various tape drives.

Overview
This chapter contains instructions for starting the VOP applications. Because the 
operating systems provide multiple means to start (launch) the VOP applications, you 
can choose any one of those listed:

■ “Windows” on page 52
■ “Linux/UNIX” on page 59
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Windows
There are two separate VOP applications:

■ T-series VOP

■ “The ltoVOP Application (Windows)” on page 56

The T-series VOP (Windows)
You can start the VOP application in the following ways:

■ “To Use the Windows Start Menu, Programs List”  on page 53
■ “To Use the Desktop Shortcut (Windows)” on page 53
■ “To Use Windows Explorer” on page 54. 
■ “To Use the Run Dialog Box (Windows)” on page 54

The application appears in a separate window as shown in the following figure:

Note – At this point, the application is open, but a drive connection has not been 
established. The key indications that VOP is not connected to the drive are the Drive 
Name = NONE, only two menu names are blue, and all the status indicators are black.

See Chapter 4, “VOP Operation - T-series Tape Drives” for detailed information on 
connecting to a drive and using the application.

FIGURE 3-1 VOP, Not Connected (Windows Version)
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▼ To Use the Windows Start Menu, Programs List 
During VOP installation, the installation wizard created a pointer in the start menu 
program list to the VOP executable file.

1. Click Start and select the All Programs > VOP folder. 

Note – The installation process for certain versions of VOP provides a quick start for 
LTOVOP. Make sure to select the VOP option if multiple options are present.

2. Click the pointer name.

The VOP window opens (FIGURE 3-1 on page 52). 

Note – There is a noticeable delay for the VOP application window to open for the first 
time of every PC power-on session while your anti-virus scans. Subsequent VOP 
launches, in the same powered session, are quicker. 

▼ To Use the Desktop Shortcut (Windows) 
If a desktop shortcut is present:

● Double-click the shortcut icon.

The VOP opens (FIGURE 3-1 on page 52). 

Note – The installation wizard generally creates a desktop shortcut.
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▼ To Use Windows Explorer 
You can start VOP from Windows Explorer:

● Navigate to the VOP folder, then double-click the sunVOP.bat file.

The VOP opens (FIGURE 3-1 on page 52). 

▼ To Use the Run Dialog Box (Windows) 
Use the following guidelines to launch VOP from the Run dialog box:

1. Click Start.

The Start menu opens.

2. Select Run.

The Run dialog box opens.
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3. Do one of the following:
■ Enter the path to the VOP executable file.
■ Click the down arrow to select a previous entry.
■ Click the Browse command button to locate the desired VOP executable file.

Note – The path must point through the specific folder.

4. Click OK.

The VOP opens (FIGURE 3-1 on page 52). 
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The ltoVOP Application (Windows)
You can start the ltoVOP application in the following ways:

■ “To Use Windows Explorer”  on page 57
■ “To Use the Windows Desktop Shortcut Icon”  on page 57
■ “To Use the Windows Run Dialog Box”  on page 57
■ “To Use the Windows Start Menu, Programs List”  on page 58

The application appears in a separate window as shown in the following figure.

Note – At this point, the application is open, but a drive connection has not been 
completed. The key indications that VOP is not connected to the drive are the lack of an 
IP address in the title bar, the grey color of the Connect button, and all status indicators 
are black.

See Chapter 5, “VOP Operation - LTO” for detailed information on the ltoVOP 
application.

FIGURE 3-2 LTO-4 Virtual Operator Panel (Windows Version)
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▼ To Use Windows Explorer 
You can start ltoVOP from Windows Explorer

● Navigate to the VOP folder, then double-click the ltoVOP.bat file. 

The ltoVOP opens (FIGURE 3-2 on page 56).

▼ To Use the Windows Desktop Shortcut Icon 
Use this method if you have a desktop shortcut.

● Double-click the shortcut icon.

The ltoVOP window opens (FIGURE 3-2 on page 56). 

▼ To Use the Windows Run Dialog Box
1. Click Start.

2. Select Run.

The Run dialog box opens.

3. Do one of the following:
■ Enter the path to the desired VOP executable file.
■ Click the down arrow to select a previous entry.
■ Click the Browse command button to locate the desired VOP executable file.
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Note – The path must point through the specific folder.

4. Click OK.

The ltoVOP window opens (FIGURE 3-2 on page 56). 

▼ To Use the Windows Start Menu, Programs List 
During VOP installation, the installation wizard created a pointer in the start menu 
program list to the LTOVOP executable file.

1. Click Start and select the All Programs > VOP folder. 

Note – The installation process for certain versions of VOP provides a quick start for 
LTOVOP. Make sure to select the VOP option if multiple options are present.

2. Click the pointer name (LTOVOP).

The LTO VOP window opens (FIGURE 3-2 on page 56). 

Note – There is a noticeable delay for the LTO VOP application window to open for the 
first time of every PC power-on session while your anti-virus scans. Subsequent VOP 
launches, in the same powered session, are quicker. 
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Linux/UNIX
There are two separate VOP applications:

■ T-series VOP
■ “The ltoVOP Application (Linux/UNIX)” on page 62

The T-series VOP
You can start the VOP application in the following ways:

■ “To Use a Terminal Window (Linux/UNIX)”
■ “To Use a Shortcut (Linux/UNIX)” on page 60
■ “To Use the File Browser (Linux/UNIX)” on page 61

Note – At this point, only the application window is open. A drive connection has not 
been initiated.

See FIGURE 1-1 on page 19 for a description of the application window sections.

See Chapter 4, “VOP Operation - T-series Tape Drives” for detailed information on the 
sunVOP application.

FIGURE 3-3 VOP, Not Connected (Solaris)
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▼ To Use a Terminal Window (Linux/UNIX)
1. Click Launch, then select Applications > Utilities > Terminal. 

A terminal window opens.

2. Change the directory to /usr/local/VOP.

3. Enter ./sunVOP. 

The VOP application launches, not connected (FIGURE 3-3). 

Note – If you include the drive’s IP or alias, VOP will open and auto-connect to the 
designated drive.

▼ To Use a Shortcut (Linux/UNIX)
1. Double-click the desktop VOP shortcut icon.

2. Click Run in the Run or Display? dialog box. 

The VOP application launches and the VOP application window opens (see FIGURE 3-3).
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▼ To Use the File Browser (Linux/UNIX)
1. Start the File Browser. 

2. Click the File System icon.

3. Open the VOP folder.

Tip – The installation wizard generally creates the folder in the /usr/local directory. 

4. Double-click the sunVOP file. 

5. Click Run in the Run or Display? dialog box.

The VOP application launches and the VOP application window opens (see FIGURE 3-3).
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The ltoVOP Application (Linux/UNIX)
You can start the ltoVOP application in the following ways:

■ “To Use a Terminal Window (Linux/UNIX)”
■ “To Use the File Browser (Linux/UNIX)” on page 63

See Chapter 5, “VOP Operation - LTO” for detailed information on the ltoVOP 
application.

FIGURE 3-4 LTO-4 Virtual Operator Panel (Solaris)
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▼ To Use a Terminal Window (Linux/UNIX)
1. Click Launch, then select Applications > Utilities > Terminal

A terminal window opens.

2. Change the directory to /usr/local/VOP.

3. Enter ./ltoVOP. 

The ltoVOP application launches, not connected (see FIGURE 3-4). 

Note – If you include the drive’s IP or alias, VOP opens and connects to the designated 
drive.

▼ To Use the File Browser (Linux/UNIX)
1. Start the File Browser. 

2. Click the File System icon.

3. Open the VOP folder.

Tip – The installation wizard generally creates the folder in the /usr/local directory. 
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4. Double-click the ltoVOP file. 

5. Click Run in the Run or Display? dialog box.

The VOP application launches and the VOP application window opens (see FIGURE 3-4).
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VOP Operation - T-series Tape Drives

This chapter describes operation of the Virtual Operator Panel (VOP) over a direct 
connection to the Ethernet port of a T9840D or T10000 tape drive (see FIGURE 4-1). See 
Appendix B for additional guidelines when operating VOP within a multiple-drive 
private network. The VOP does not interact with the host data input/output interface. 

The VOP has three basic operational functions:

■ Monitor drive status
■ View or change drive configuration settings
■ Use drive operation utilities

When a Service Delivery Platform (SDP) site unit is installed and monitoring tape 
drives over an Ethernet private network, the drive Ethernet port is 100% dedicated to 
the service network. Therefore, the drive Ethernet port is not available for connection to 
the customer VOP. 

FIGURE 4-1 T10000 Tape Drive Rear Panel 

1. Ethernet Port 
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Note – Many of the sunVOP application window illustrations in this section were 
captured on a Windows XP platform running VOP version 1.0.14 and T10000 tape drive 
code level 1.44.x06. While the Linux/UNIX platform VOP application window has a 
slightly different look (see FIGURE 3-3 on page 59), the guidelines apply equally. Using a 
different VOP version or drive code level might produce alternate results such as: a 
different number of commands in a given main menu, different labeling of the 
encryption status LED, or different parameter values for a configuration attribute.

Use sunVOP Menus and Controls
The VOP application window provides several menus. When the drive is online, the 
unavailable Configure menu label is dimmed (see FIGURE 4-2). Some menu commands 
have additional sub-menus or dialog boxes. 

During the course of selected operations, the VOP text message pane displays a 
transcript of the VOP actions or a prompt for additional input or actions.

Some status indicators are also an active link that permits you to toggle the state of the 
monitored drive item. Note that the mouse cursor does not change when you place the 
cursor on that type of indicator.

Note – The following sections provide more detailed guidelines.

▼ To Use Menu Bar Selections
In general, the following two steps are basic for all menus:

1. Choose an available menu label.

FIGURE 4-2 VOP Window Menus and Indicators/Controls 
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Tip – You can click a menu name or use shortcut keys.

A drop-down list of available commands appears.

2. Select a command or sub-menu.

Note – Shortcuts keys are available for selected commands.

The drive message text window, drive status indicators, and the VOP text message 
pane provide informational feedback.

File Menu 

Note – Commands in the File and Help menu are available whether VOP is connected 
to a drive or not, and if connected when the drive is either online or offline.

The File menu (FIGURE 4-3) has four commands. A description of each command is 
provided in the following table.

TABLE 4-1 File Menu Commands

Command Description

Clear Transcript Clears the entire VOP transcript pane and closes the file menu. 

Connect to Drive Connects VOP to the tape drive.
Note - You must be connected to the drive before you can use the Drive Operations, 
Retrieve, or Configure menus.

Collect Support Logs Collects drive log files that you can forward to product support for analysis.

Exit Disconnects VOP from the tape drive and closes the VOP window.

FIGURE 4-3 File Menu Commands 
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▼ To Use the Clear Transcript Command
Use the Clear Transcript command to empty the transcript pane.

1. Open the File menu. 

Tip – Choose File from the menu bar or use the ALT+F shortcut keys.

2. Choose Clear Transcript from the File menu. 

The entire VOP transcript pane clears and the file menu closes.

▼ To Use the Connect to Drive Command
Use the following guidelines to connect VOP to a designated drive:

1. Open the File menu. 

Tip – Choose File in the menu bar or use the ALT+F shortcut keys.

2. Choose Connect to Drive from the File menu or use the SHIFT+C shortcut keys.

The Connect to Drive dialog box opens. 

3. Enter the drive’s IP address or alias in the dialog box, then click OK.

After the VOP establishes connection with the designated drive, the VOP window 
changes to the connected stage.

FIGURE 4-4 Connect to Drive Dialog Box
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In the connected stage, the menu bar contains the drive IP address or alias, additional 
menus are accessible, the status indicators are a color other than black, and the text 
pane/transcript contains message text.

4. (Optional) To connect VOP to a different drive, perform the appropriate action:

a. Determine if you are using a crossover cable connection to a single drive:

■ If no, go to Step b.

■ If yes, perform the following actions:

i. Disconnect the crossover cable from the tape drive.

ii. Reconnect the cable to a different drive. 

■ If the drive has the same IP address as the previous drive, VOP automatically 
reconnects. 

■ If the drive has a different IP address, perform Step 2 and Step 3 to designate the 
IP address of the new drive.

b. Leave the PC private-network, Ethernet cable connected to the Ethernet switch and 
designate the new drive IP address (see Step 2 and Step 3). 

Note – The text pane shows that VOP disconnects from the old drive and connects to 
the new Drive IP address.

▼ To Use the Collect Support Logs Command
1. Open the File menu. 

Tip – Choose File from the menu bar or use the ALT+F shortcut keys.

2. Choose Collect Support Logs from the File menu.

A text pane message appears after each log is collected, and a final message indicates 
the location of the archive (.zip) message file.

Note – An information message appears if WinZip is not installed on your PC.

▼ To Use the Exit Command
1. Open the File menu. 

Tip – Choose File from the menu bar or use the ALT+F shortcut keys.

2. Choose Exit from the File menu or use the SHIFT+E shortcut keys.

The VOP application window closes. If the VOP was connected to a drive, the Ethernet 
connection terminates.
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Drive Operations Menu 

Note – You should consult either the T10000 Tape Drive Operator’s Guide (P/N 96174) or 
the T9840 Tape Drive User’s Reference Manual (P/N 95739) for additional information 
regarding the tape drive, use of a cartridge tape, and general operating procedures.

The Drive Operations menu (FIGURE 4-5) has six commands. You can access the menu 
by choosing Drive Operations in the menu bar or by using the ALT + D shortcut keys. 
A description of each command is provided in the following table.

Note – Notice that the Format Tape label is dimmed to indicate that this command is 
only available when the drive is offline. 

TABLE 4-2 Drive Operations Menu Commands

Command Description

Load Tape This command causes a cartridge that is present in the cartridge loading slot to load.

Unload Tape This command causes a loaded cartridge to rewind and unload. 

Set Offline or  
Set Online 

This command changes the state of the tape drive. The command name is opposite of the 
current drive state (Set Offline when the drive is online and Set Online when the drive is 
offline).

IPL Drive This command causes the tape drive to perform an initial program load (IPL).

Force Dump This command forces a diagnostic dump of the current contents of various drive registers.

Format Tape This command reformats a cartridge tape as a code tape, a data tape, or a dump tape. It also 
provides the capability to rebuild the contents of the tape Media Information Region (MIR).

FIGURE 4-5 Drive Operations Menu Commands 
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▼ To Use the Load Tape Command 
Use this command to reload a cartridge that was previously unloaded but that was not 
removed from the tape drive loading slot. 

1. Open the Drive Operations menu.

Tip – Click Drive Operations in the menu bar or use the ALT+D shortcut keys.

2. Choose Load Tape from the Drive Operations menu or use the SHIFT+L shortcut 
keys. 

The drive loads the cartridge that is present in the tape drive loading slot. A ready 
message appears in the primary drive message window after the tape advances to the 
beginning of tape (FIGURE 4-2 on page 66). A message also appears in the text pane to 
identify that the cartridge is loaded.

▼ To Use the Unload Tape Command 
1. Open the Drive Operations menu.

Tip – Click Drive Operations in the menu bar or use the ALT+D shortcut keys.

2. Choose Unload Tape from the Drive Operations menu or use the SHIFT+U shortcut 
keys. 

A loaded cartridge rewinds and unloads. The text pane shows the unload message and 
a message appears in the primary drive message window.

3. Remove the tape cartridge from the drive load slot.

Note – You must physically remove an unloaded cartridge from the drive by library 
robotics or manually from the rack mount configuration. Otherwise, the cartridge 
remains in the loading slot, but not loaded into the drive.

▼ To Use the Set Offline/Online Command 
■ When the tape drive is online, this command reads Set Offline. 

■ When the tape drive is offline, this command reads Set Online. 

1. Open the Drive Operations menu.

Tip – Click Drive Operations in the menu bar or use the ALT+D shortcut keys.
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2. Choose the Set command from the Drive Operations menu or use the SHIFT+O 
shortcut keys. 

The message pane example below shows when the Set OFF-LINE operation starts and 
when the tape drive is OFF-LINE. As the drive goes offline, the status indicator turns 
gray, the label changes to Offline, and the Offline message appears in the primary drive 
message window. 

In addition, the label for the Configure menu turns blue.

Note – You can also click the Online/Offline status indicator to change the drive state.

▼ To Use the IPL Drive Command
1. Open the Drive Operations menu.

Tip – Click Drive Operations in the menu bar or use the ALT+D shortcut keys.

2. Choose IPL Drive from the Drive Operations menu. 

The tape drive performs an initial program load (IPL).

Note – VOP loses communications with the drive during the IPL. Once the drive IPL is 
successfully completed, VOP automatically reconnects with the drive. 
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▼ To Use the Force Dump Command
1. Open the Drive Operations menu.

Tip – Click Drive Operations in the menu bar or use the ALT+D shortcut keys.

2. Choose Force Dump from the Drive Operations menu. 

The drive stores the dump to internal memory, and the dump status indicator changes 
to orange. The forced dump operation causes a drive IPL, and the VOP loses connection 
with the drive during the IPL. After the drive successfully completes the IPL, FFFA 
appears in the secondary drive message window. See the following figure. 
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Format Tape Command

Note – You must load (mount) and unload (dismount) a cartridge when you use any of 
the Format Tape functions. This might require you to use a library control path 
command or utility.

The offline Format Tape command launches a dialog box that provides four utilities 
that are described in the following table. 

The dialog box also contains three command buttons:
■ Make - Initiates the selected utility.
■ Abort - You can select this option before you load a cartridge in the drive to 

terminate the utility.
■ Done - Closes the dialog box.

Caution – Possible data loss. Do not use a customer data tape to make a code tape or 
a dump tape.

TABLE 4-3 Format Tape Utilities 

Function Description

Make data tape The Make Data Tape utility reformats a tape cartridge for reuse as a 
data tape cartridge. Existing headers are removed and the Media 
Information Region (MIR) is rewritten to identify the cartridge as 
empty and therefore ready for write operations.

Make code tape The Make Code Tape utility reformats a tape cartridge with a special 
format, and downloads the drive firmware from the drive memory to 
the tape cartridge. The MIR is then written to identify the cartridge as 
a code tape. You can use the code tape to upload drive firmware to 
other tape drives. 
The T9840D requires a configuration setting (see FIGURE 4-23 on page 
100) followed by the loading of a full code image.

Make dump tape The Make Dump Tape utility reformats a tape cartridge with a special 
format. The MIR is written to identify the cartridge as a dump tape. 
You can use a formatted dump tape to download diagnostic dump data 
from drive memory. 

Rebuild MIR You can use the Rebuild MIR utility to repair a data tape cartridge that 
has an invalid or corrupted MIR. The utility reads the file headers all 
the way to the End of Data mark. Then, the MIR is rewritten to 
correctly reflect the tape contents. This utility could take well over one 
hour to rebuild the MIR on a full or nearly full data tape cartridge. 
See “Media Information Region” in the T10000 Tape Drive Operator’s 
Guide, PN 96174 for additional MIR information.
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▼ To Format a Tape Cartridge (Offline)
Use the following general guidelines to perform any of the utilities: 

1. Make sure the drive is offline.

If not offline, perform one of the following actions:

a. Click the Online status indicator. 

b. Select Drive Operations > Set Offline (see FIGURE 4-5 and “To Use the Set 
Offline/Online Command” on page 71).

c. Use shortcut keys (ALT+D to open the Drive Operations menu followed by 
SHIFT+O to set the drive offline).

2. Choose Format Tape from the Drive Operations menu.

The Format Tape Cartridge dialog box appears. 

3. Select the appropriate utility radio button. 

4. Click the MAKE button or use the ALT+M shortcut keys to start the selected utility. 

A prompt appears in the transcript directing you to insert a cartridge.

Note – If there is a cartridge in the drive, it unloads. You must physically remove the 
unloaded cartridge.

Tip – You can cancel a selected utility by clicking the ABORT button or use the  
ALT + A shortcut keys before inserting the cartridge. Once the cartridge is inserted, the 
utility runs to completion.

Caution – Do not use the Make Code Tape or Make Dump Tape functions with a 
customer data tape.

5. Insert a write-enabled cartridge.

Tip – See FIGURE 4-6 on page 76 for the location of the write-protect switch. Make sure the 
switch is in the write-enabled position as indicated by the open padlock icon.
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The drive performs the selected utility, displays related information in the VOP 
transcript pane, then unloads the cartridge.

6. Remove the unloaded cartridge.

You now have the following options:

■ Repeat the current selected format tape command (go to Step 4 on page 75).

■ Select a different format tape command (go to Step 3 on page 75).

■ Exit the format tape submenu (continue with Step 7).

7. Click the DONE button or use the ALT+D shortcut keys to exit the format tape 
submenu.

The Format Tape Cartridge dialog box closes.

FIGURE 4-6 Tape Cartridge Write-Protect Switch 

1. Write-protect switch
2.  Unlocked position
3.  Locked position

T103 4091

2

3
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Retrieve Menu 
The Retrieve menu (FIGURE 4-7) has five commands. You can access the menu by 
choosing Retrieve in the menu bar or by using the ALT+R shortcut keys. A description 
of each command is provided in the following table.

Note – The Retrieve menu is available when the drive is online or offline.

Additional information is available in the following sections:

■ “View Drive Data Command” on page 78
■ “To Use the View Date & Time Command” on page 89
■ “To Use the Save Dumps to a File Command” on page 89
■ “To Use the Perms to File Command” on page 90
■ “To Use the Logs to File Command” on page 91

TABLE 4-4 Retrieve Menu Commands

Command Description

View Drive Data This command uses selectable property sheets (tabs) to show the current drive 
configuration settings and other drive data.

View Date & Time This command shows the setting of the internal timer in the drive.

Dumps to File This command retrieves and saves diagnostic dumps that are currently stored in the 
drive memory.

Perms to File This command retrieves and saves all the permanent errors that are currently stored in 
the drive memory. 

Logs to File This command retrieves and saves event logs that are currently stored in the drive 
memory.

FIGURE 4-7 Retrieve Menu  



 

Retrieve Menu

78 VOP Customer User’s Guide • December 2009   Revision JB • 96179

View Drive Data Command 
The View Drive Data command uses selectable property sheets (tabs) to show the 
current drive configuration settings and other drive data. The property sheets names 
for an encryption-capable drive are:

■ Encrypt (encryption-capable drive)
■ Fibre - shows either Fibre Channel or FICON properties based upon the interface
■ Keyid (encryption-capable drive)
■ Manufacturing
■ Missing (encryption-capable drive)
■ Network
■ Rfid (a cartridge must be loaded in the drive) - not available on a T9840D drive
■ Version

The View Current Settings window of an encryption-capable drive shows the Encrypt 
tab (FIGURE 4-8) while a drive that is not encryption-capable shows the Fibre tab 
(FIGURE 4-10). 

Note – Several of the following pages contain example property sheets.

▼ To Use the View Drive Data Command
1. Choose Retrieve from the menu bar or use the ALT+R shortcut keys to open the 

menu.

2. Choose View Drive Data from the Retrieve menu or use the SHIFT+V shortcut keys.

The View Current Drive Settings window appears. 

Note – The View Current Drive Settings property sheets are for viewing purposes only. 
See “Configure Menu” on page 92 for detailed descriptions and guidelines regarding 
the changing of any configuration setting. 

3. Click the tab for the property sheet that you want to view.

The property sheet shows the current drive settings for that property.

4. (Optional) Click a different property sheet tab. 

Note – Repeat this step as necessary to gather all required information.

5. Click the OK button or use the ALT+O shortcut keys to close the window.
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Encrypt Property Sheet
The Encrypt tab shows encryption-related data: see FIGURE 4-8 for a T10000 drive or see 
FIGURE 4-9 on page 80 for a T9840D drive. 

If you want additional information on FIPS aspects of the drive, see the document titled 
either T10000A Encrypting Tape Drive Security Policy or T10000B Encrypting Tape Drive 
Security Policy.

FIGURE 4-8 View Current Drive Settings, Encrypt Tab - T10000 Drive
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FIGURE 4-9 View Current Drive Settings, Encrypt Tab - T9840D Drive
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Fibre Property Sheet
The data shown on the Fibre tab is specific to the type of drive interface.  
The Fibre Channel Protocol (FCP), shown in FIGURE 4-10, has FCP specific data. The 
Fibre Interface Connection (FICON), shown in FIGURE 4-11 on page 82 has FICON specific 
data. There is a similar list of parameters for a T9840D drive.

 

FIGURE 4-10 View Current Drive Settings, Fibre Tab (FCP Interface) 
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The Fibre tab for the FICON interface (FIGURE 4-11) is very similar to the FCP interface 
(FIGURE 4-10 on page 81), with the exception of the FICON-specific emulation setting.

 

FIGURE 4-11 View Current Drive Settings, Fibre Tab (FICON Interface) 
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Keyid Property Sheet
The Keyid tab (FIGURE 4-12) shows a list of key identifiers.

FIGURE 4-12 View Current Drive Settings, Keyid 
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Manufacturing Property Sheet
The Manufacturing tab (FIGURE 4-13) shows factory preset settings, such as drive serial 
number, and default world wide names.

Note – The serial number of a T10000A drive begins with 531 while the serial number 
of a T10000B drive begins with 572. 
The drive model number of a T10000A drive appears as T10000 (see the figure above) 
while the model number of a T10000B drive appears as T10000B.

FIGURE 4-13 View Current Drive Settings, Manufacturing Tab 
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Missing Property Sheet
The Missing tab (FIGURE 4-14) shows a list of missing key identifiers.

FIGURE 4-14 View Current Drive Settings, Missing 
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Network Property Sheet
The Network tab (FIGURE 4-15) shows the Network node name. The factory preset 
default is comprised of the drive model number (t10000) and the last nine digits of the 
drive serial number. 

This tab also shows the current static IP settings. FIGURE 4-15 shows factory preset static 
IP parameters, which can be changed through the Configure menu  
(see “Network Property Sheet” on page 108).

FIGURE 4-15 View Current Drive Settings, Network Tab 
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Rfid Property Sheet
The Rfid tab (FIGURE 4-16) shows data stored in the radio-frequency identification (Rfid) 
memory chip in the T10000 tape cartridge. The Rfid chip stores data related to cartridge 
contents and statistics. The data is similar to data stored in the media information 
region (MIR) on the tape, and is updated with each cartridge mount/dismount. An Rfid 
module in the drive reads the Rfid chip while the cartridge is loaded, and is viewable 
(read-only) by the VOP application.

FIGURE 4-16 View Current Drive Settings, Rfid Tab 
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Version Property Sheet
The Version tab (FIGURE 4-17) shows the current drive firmware level.

 

FIGURE 4-17 View Current Drive Settings, Version Tab 
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▼ To Use the View Date & Time Command
● Choose View Date & Time from the Retrieve menu. 

The drive date and time appears in the VOP transcript pane, as shown below. 

Notice that the drive clock setting is lagging behind the VOP time at the left side of the 
same text line. The drive clock only operates while the drive is powered; therefore, the 
drive clock time can fall behind real clock time whenever the drive is not powered. 
Most library configurations set the drive clock in-sync with the library clock. However, 
you can manually set the drive clock when the drive is offline.

Note – See “To Use the Set Clock Command” on page 112 to change the drive clock 
setting.

▼ To Use the Save Dumps to a File Command
1. Choose Dumps to File. from the Retrieve menu 

The save dialog box appears to allow you to name the file and identify where to save it.

2. Name the file, specify the target folder, and click Save.

The operating system saves the dump file in the specified location. The VOP transcript 
(shown below) documents the action, including the path to the file.



 

Retrieve Menu

90 VOP Customer User’s Guide • December 2009   Revision JB • 96179

Note – The dump indicator dimmed after retrieval of the dump file. However, the 
dump is still present in drive memory until intentionally deleted by a service 
representative or until the drive firmware is updated.

▼ To Use the Perms to File Command 
1. Choose Perms to File from the Retrieve menu. 

The save dialog box appears to allow you to name the file and identify where to save it.

2. Name the file, specify the target folder, and click Save.

The operating system saves the perm file in the specified folder. The VOP transcript 
(shown below) documents the action, including the path to the file. 
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▼ To Use the Logs to File Command 
1. Choose Logs to File from the Retrieve menu. 

The save dialog box appears to allow you to name the file and identify where to save it.

2. Name the file, specify the target folder, and click Save.

The operating system saves the log file in the specified folder. The VOP transcript 
(shown below) documents the action, including the path to the file. 
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Configure Menu

Note – The drive must be offline, and should not be available to the host when you 
exercise the Configure menu commands. Some changes require the drive to perform an 
Initial Program Load (IPL) to implement configuration changes. 

The offline Configure menu (FIGURE 4-18) has four commands. You can access the menu 
by choosing Configure in the menu bar or by using the ALT+C shortcut keys. A 
description of each command is provided in the following table. 

Additional details are provided in the following sections:

■ “Drive Data Command” on page 93
■ “To Use the Save Drive Config Command” on page 111
■ “To Use the Set Clock Command” on page 112
■ “To Use the Code Load from Tape Command” on page 113

TABLE 4-5 Configure Menu Commands

Command Description

Drive Data This command allows you to change configuration settings.

Save Drive Config This command allows you to save the current drive configuration settings to a file. 
You can retrieve the saved file to restore configuration settings.

Set Clock This command allows you to set the drive’s internal clock to the current time in your 
computer.

Code Load from Tape This command allows you to update the drive’s firmware to the release level 
contained on a prerecorded Code Load Tape (cartridge).

FIGURE 4-18 Configure Menu
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Drive Data Command

Note – The current drive parameter settings were selected by the installation team to 
match pre-determined site requirements. Changing the drive parameter setting could 
materially affect drive performance. Therefore, you should change drive parameter 
settings only as instructed by your IT manager or Sun StorageTek Support.

The Drive Data command presents you with the Configure Drive Parameters property 
sheets to change configuration settings. When you select a property sheet (tab), the 
current drive parameter values appear. If you change a setting, the adjacent Update 
checkbox indicates a pending change. Clearing the checkbox cancels the pending 
change of only that parameter.

The following figure shows the Fibre property sheet with a language change to 
Francais, and the corresponding check in the Update column. 

Notice that there are several selection methods on the property sheets:

■ Drop-down list boxes 
■ Radio buttons
■ Text fields

Across the bottom of the Configure Drive Parameters dialog box, there are three 
command buttons that directly affect drive configuration settings. The buttons are 
described in the following table.
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TABLE 4-6 Configure Drive Parameter Buttons 

Note – During the commit process, VOP loses connection to the drive when IPL 
begins. However, VOP automatically reconnects to the drive after a successful IPL.

After the drive completes IPL and VOP reconnects to the drive, you should review 
Retrieve > Drive Data tabs to verify the new parameter values/settings (see “View 
Drive Data Command” on page 78). If required, place the drive offline, and repeat the 
configuration process (see “Drive Data Command” on page 93). 

Before discussing the available configuration settings, you should be familiar with the 
three command buttons across the bottom of every tab.

▼ To Use the Drive Data Command - Manual Entry
1. Choose Configure from the menu bar or use the ALT+C shortcut keys to open the 

menu.

2. Choose Drive Data from the Configure menu or use the SHIFT+D shortcut keys.

The multi-tab Configure Drive Parameters property sheet appears. 

3. Click the tab for the property sheet that you want to change.

Note – The Encrypt property sheet opens for an encryption-capable drive or the Fibre 
property sheet opens for drive that is not encryption-capable.

Button Description

Load Drive Config This function allows you to retrieve a previously saved file 
containing drive configuration parameters/settings. After the 
retrieved file is opened, all tabs are populated with the saved 
configuration parameter values/settings. Marked Update 
checkboxes identify changed parameter values/settings.
Note: The imported saved configuration file includes parameters 
specific to the originating drive. Make sure you clear or reset 
drive-specific parameters to accurately reflect the drive that 
imported the saved configuration file.
See “To Use the Save Drive Config Command” on page 111 for 
guidelines on saving a drive configuration.

Commit Initiates a drive IPL to activate pending changes.

Cancel Clears any/all pending change selections for all four tabs.
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4. Enter a change on the property sheet.

A check appears in the box in the Update column to the right of your change.

Tip – Repeat this step as necessary to identify additional changes.

5. (Optional) Click the tab for a different property sheet and enter your change(s).

Note – You can use the Cancel button or the ALT+N shortcut keys to cancel all 
pending changes.

6. Click the Commit button or use the ALT+C shortcut keys.

The drive performs an IPL to implement the identified change(s).

▼ To Use the Drive Data Command - Config File
1. Choose Configure from the menu bar or use the ALT+C shortcut keys to open the 

menu.

2. Choose Drive Data from the Configure menu or use the SHIFT+D shortcut keys.

The multi-tab Configure Drive Parameters property sheet appears. 

3. Use the Load Drive Config button or the ALT+L shortcut keys to import a saved 
configuration file. 

A dialog box appears where you enter the file name and path or use the browse 
function. The property sheets are populated with data from the retrieved file.

4. (Optional) Remove the check or alter unneeded parameter changes imported from a 
configuration file.

Tip – Pay particular attention to the drive-specific parameter values on each of the 
property sheets.

Note – You can use the Cancel button or the ALT+N shortcut keys to cancel the 
pending changes.

5. Click the Commit button or use the ALT+C shortcut keys.
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The drive performs an IPL to implement the identified change(s).

Encrypt Property Sheet
The Encrypt tab contains information about the encryption characteristics of the drive 
(such as, use of tokens or permanently encrypting) and enrollment information. 
FIGURE 4-19 shows the property sheet for a T10000 drive and FIGURE 4-20 on page 97 shows 
the property sheet for a T9840D drive. 

Note – See either the encryption documentation for guidelines on how to use this 
property sheet or the T10000 Tape Drive Operator’s Guide for information on using Data 
Path Key Management (DPKM).

If you want additional information on FIPS aspects of the drive, see the document titled 
either T10000A Encrypting Tape Drive Security Policy or T10000B Encrypting Tape Drive 
Security Policy.

FIGURE 4-19 Configure Drive Parameters, Encrypt Tab T10000 Tape Drive
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FIGURE 4-20 Configure Drive Parameters, Encrypt Tab T9840D Tape Drive
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Fibre Channel Fibre Property Sheet
The Fibre tab (FIGURE 4-21) contains drive Fibre Channel configuration settings for the 
T10000A tape drive. The parameters are similar for the T10000B or T9840D tape drive. 

Notice that there are three different selection methods on the Fibre tab:

■ Drop-down list boxes - Emulation, Language, Pa/b max recv size, and Pa/b 
speed negotiation.

■ Radio buttons - Data compression, Data security erase, Standard Label protect, 
Tape completion display, Pa/b hrd asgn phys addr, and Pa/b soft asgn phys addr.

■ Text fields - Library address and World Wide Name (drive, ports A & B).

Note – See FIGURE 4-22 on page 99 for the FICON Fibre tab.

FIGURE 4-21 Configure Drive Parameters, Fibre Tab (FCP)
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FICON Fibre Property
The FICON Fibre tab for a T10000 tape drive (FIGURE 4-22) or a T9840D tape drive 
(FIGURE 4-23 on page 100) contains drive FICON configuration settings. 

Notice that there are three different selection methods on the Fibre tab:

■ Drop-down list boxes - Emulation, Language, Pa/b max recv size,  
and Pa/b speed negotiation.

■ Radio buttons - Data compression, Data security erase, Standard Label protect,  
Tape completion display, Pa/b hrd asgn phys addr, and Pa/b soft asgn phys addr.

■ Text fields - Library address, and World Wide Name (drive, ports A & B).

Note – See FIGURE 4-21 on page 98 for the FCP Fibre tab.

 

FIGURE 4-22 Configure Drive Parameters, Fibre Tab (FICON)
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FIGURE 4-23 Configure Drive Parameters, T9840D 
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The following sections provide additional detail for parameter settings.

Note – The current drive parameter settings were selected by the installation team to 
match predetermined site requirements. Changing the drive parameter setting could 
materially affect drive performance. Therefore, you should change drive parameter 
settings only as instructed by your IT manager or Sun StorageTek Support.

Emulation

The available emulation options are specific to the active interface and the tape drive 
model.

Note – The option list nomenclature or the specific options available might differ from 
those shown based upon the version of drive microcode.

FIGURE 4-24 shows a representative list of T10000A Fibre Channel options: Standard-
FIBRE, 9840B-FIBRE, 9940B-FIBRE, and 3592-FIBRE.

FIGURE 4-25 shows a representative list of T10000A FICON options: VSM3490-FICON 
and 3592-FICON. 

Note – T9840D emulation options are different.

FIGURE 4-24 T10000A Emulation Options - FCP

FIGURE 4-25 T10000A Emulation Options - FICON
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Data Compression

The following figure shows the available data compression options and TABLE 4-7 
provides a description of each option. 

Note – Data compression radio buttons are mutually exclusive. The option defaults to 
the last saved selection. Yes is the factory setting. 

Data Security Erase

The following figure shows the available data security erase (DSE) options and 
TABLE 4-8 provides a description of each option. 

Note – The DSE radio buttons are mutually exclusive. The option defaults to the last 
saved selection. Yes has been the factory setting since June 2008 (drives manufactured 
before that date were set to No). 

TABLE 4-7 Data Compression Option Descriptions

Option Use/Meaning

No Data is not compressed, by default, but can be overridden by the host for a 
job.

Yes Data is compressed, by default, but can be overridden by the host for a job. 

Off Data compression is disabled by default, and cannot be overridden by the 
host. 

TABLE 4-8 DSE Option Descriptions

Option Use/Meaning

Yes Enables a full DSE. A random binary pattern is written on the media, over-
writing existing data, from the point of an “Erase” command to the End of 
Tape mark. 

No Writes an end of data mark on the media that indicates valid data does not 
exist beyond the point of an “Erase” command. Data is actually still present 
beyond the end of data mark, and it can be retrieved by special tape utilities.
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Standard Label Protect

The following figure shows the available standard label protect (SL Prot) options and 
TABLE 4-9 provides a description of each option. 

Note – The SL Prot radio buttons are mutually exclusive. The option defaults to the 
last saved selection. No is the factory setting. 

Library Address

The Library Address is a text field that contains a two-character hexadecimal value that 
the factory sets to ff as shown in the following figure. 

Note – The setting should remain at ff for all libraries except the 9310 PowderHorn 
Library. A valid entry for the 9310 is based upon the tape drive position in the 
9741/9741E drive cabinet (00 through 09 [top, down], left column; or 0A through 13 
[top, down] right column) as viewed from the access door of the cabinet.

TABLE 4-9 Standard Label Protect Options

Option Use/Meaning

No Disables standard label protection. 

Yes Enables standard label protection. 

Notes:
Consider the following: 
1. Select Yes if label overwrite code is loaded, or if running standard labels and wish the drive 

to display a fatal error (CHK 33EX) when writing a non-80-byte record for VOLSER or 
HDR1.

2. Select No if you are using NL or NSL tape processing.
3. POST WRCART cannot be run with Yes selected
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Tape Completion Display

The Tape completion display provides an indication of tape completion (percentage of 
tape media with written data) as shown in the following figure.

Note – The view-only tape completion display is superseded by higher priority messages 
that require use of the secondary window.

When you select No, the tape completion display is disabled.

When you select Yes, the tape completion display appears in the secondary drive 
message window when there is a cartridge loaded in the drive. 

The available options are shown in the following figure. 

Note – The radio buttons are mutually exclusive. The option defaults to the last saved 
selection. No is the factory setting. 

Language 

Note – English is preset at the factory.

The available language selections are shown in the following figure. 

This option sets the language in which certain operational drive messages (such as 
loading, unloading, etc.) appear in the drive message windows. 
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World Wide Name 

Caution – Indiscriminately changing the WWN could result in the drive being 
unavailable to the host. 

The World Wide Name (WWN) identifies the drive node. This string of 16 hexadecimal 
characters (FIGURE 4-26) represents a 64-bit unique identifier that distinguishes the 
individual drive from all other devices worldwide. Characters 2 through 6 identify the 
specific manufacturer. Sun StorageTek branded devices have the company ID “00104F”. 
Other characters reveal additional information, including an identifier unique only to 
the specific device. 

Note – When a customized WWN is active, ‘(custom)’ appears in the label.

Sun Microsystems assigns a block of three WWNs (from a pool of company-specific 
WWNs) to each tape drive during the manufacturing process. One for the drive and 
one each for the two fiber-optic interface ports. The drive node is assigned the first 
WWN of the block, and the next two WWNs, in sequence, are assigned to the ports. 
Notice the last two characters in FIGURE 4-26 are 9d. If you refer back to the entire fibre 
tab (FIGURE 4-21 on page 98, FCP or FIGURE 4-22 on page 99, FICON) the port A WWN ends 
with 9e, and the port B WWN ends with 9f. In addition, the (default) indicates that this 
WWN was preset at the factory. 

Certain libraries override the default WWN with a library-assigned dynamic WWN 
(dWWN). Typically, only the last four characters differ from the default WWN. When 
dWWNs are active, (library) appears in the label. 

You can also manually override the WWN with a custom WWN. In some 
circumstances, a service representative might customize a replacement drive’s WWN to 
be the same as the replaced, defective drive’s WWN. This precludes a requirement for a 
full system reset to acknowledge a new WWN.

Note – If you apply a custom WWN to the drive node, custom WWNs must also be applied 
to the interface ports.

Attributes of Interface Ports

Note – Port physical address attributes are only used when the drive is in an 
arbitrated-loop. The settings are not applicable when the drive is in an interface fabric.

There are two identical interface port attribute groups (FIGURE 4-27):

FIGURE 4-26 World Wide Name Text Field
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Tip – Pa = Port A, Pb = Port B

Hard-assigned Physical Address (No/Yes)

When Yes is selected, the drive uses a specified hard physical address (PA).  
When No (factory-preset default) is selected, the drive seeks a soft PA.

Arbitrated Loop Address (loop ID)

This entry (0 - 125) specifies the loop ID when the Hard PA selection is Yes.  
Factory-preset defaults are: 0 for Port A, 1 for Port B.

Soft-assigned Physical Address (Hi/Lo)

Soft PA is valid when the Hard PA selection is No.  
When Soft PA is Hi, the drive seeks an available loop ID in a descending order. 
When Soft PA is Lo (factory-preset default), the drive seeks an available loop ID in 
a descending order.

Maximum Receive Size

Caution – POTENTIAL DRIVE DAMAGE. Older versions of VOP display several 
size options. The smaller size options are not valid with the T10000 drive. Furthermore, 
an attempt to switch to any setting other than 2112 or 2048, could cause the drive to fail 
to complete the IPL. DO NOT SELECT A SIZE OPTION OTHER THAN 2112 or 2048.

The maximum receive (max recv) size value, shown in the following figure, determines 
the maximum data frame size for data processing. 

FIGURE 4-27 Interface Port Attributes
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The radio buttons are mutually exclusive. The option defaults to the last saved 
selection.

Note – 2112 is the factory setting. Do not change the value unless directed by your IT 
manager or Sun StorageTek Support.

▼ To Enable the Port World Wide Name Override
Each port has a unique WWN (see FIGURE 4-28) that you can override. See “World Wide 
Name” on page 105 for additional information/detail.

Note – If you apply a custom WWN to the drive node, you must also apply custom 
WWNs to the interface ports.

Note – When a customized WWN is active, (custom) appears in the label.

Speed Negotiation

Note – Do not change the speed setting unless directed by your IT manager or Sun 
StorageTek Support. 

The Speed Negotiation options depend on the capability of the interface transceiver 
present in the drive. The following figure shows the options available for a 4 Gbit drive.

■ When you select Auto, the drive operates at the negotiated interface speed, which is 
typically determined by the slowest attached device. Auto is preset at the factory. 

■ When you select a fixed rate, the drive only operates at the specified speed and 
might cause the drive to be unavailable, unless all other interface devices are set to 
the same speed. 

FIGURE 4-28 Port World Wide Name Text Fields
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Network Property Sheet
The Network tab (FIGURE 4-29) provides network related options. When you select the 
Network tab, the current settings appear. The information in the following figure is 
from a T10000 tape drive. The parameter list in the dialog box can vary based upon the 
VOP version and the drive microcode level.

Note – The entries shown in FIGURE 4-29 are preset at the factory, and they should only 
be changed at the direction of your IT manager.

The dialog box for the T9840D tape drive is similar, but instead of the Network node 
name parameter there are two parameters (MIM host IP address and MIM file path).

FIGURE 4-29 Configure Drive Parameters, Network Tab
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▼ To Set a Drive Static IPv4 Address 

Note – If your drive is monitored by a Service Delivery Platform (SDP), the SDP 
incorporates a dynamic host control protocol (DHCP) server that assigns a dynamic IP 
address to the drive.  
 
You cannot directly connect the customer VOP to drives monitored by an SDP.

The parameters shown in the following table determine the static IPv4 addressing for 
the drive. Each parameter has four 3-digit groups, factory preset to the value shown in 
the table.

For drives not monitored by an SDP, use the following procedure to edit the static IP 
address fields:

1. Overwrite the IP address digits with the specified new digits.

A check mark appears in the Update checkbox.

2. Overwrite the Subnet mask digits with the specified new digits.

3. Overwrite the Gateway digits with the specified new digits.

4. Click Commit, at the bottom of the dialog box.

Commit initiates a drive IPL to implement the changed configuration settings. You 
should click Commit only after completing all drive parameter setting changes.

Note – If you want use VOP with this drive, you must use the Connect to Drive 
process and specify the new IP address (see “To Use the Connect to Drive Command” 
on page 68).

Parameter Factory Preset Valid Entries

IP address 010.000.000.001 000 - 255 (each 3-digit group)

Subnet mask 255.255.255.000 000 - 255 (each 3-digit group)

Gateway 000.000.000.000 or 
255.255.255.255

000 - 255 (each 3-digit group)
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▼ To Set the Network Node Name
This text field (FIGURE 4-30) determines the network node name for the T10000 tape 
drive. 

Note – The factory preset default is: t10000 - <last nine digits of drive serial number>.

To set a different network node name:

1. Overwrite the appropriate characters with the specified new characters.

A check mark appears in the Update checkbox.

Note – The factory preset network node name should only be changed by specific 
instructions from your IT manager, or Sun StorageTek Support. 
 
If you use a saved configuration file (from a different drive) to change settings, clear the 
update check box. Otherwise, the network node name will change, which could 
negatively impact network operations.

2. Click Commit, at the bottom of the dialog box, if you do not have other changes. 
Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed configuration settings. You 
should click Commit only after completing all drive parameter settings for change.

FIGURE 4-30 Node Name
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▼ To Use the Save Drive Config Command 
1. Create a folder to store the drive configuration file.

2. Make sure the drive is offline.

If the drive is not offline, set it offline.

Note – The Configure label must be blue to allow menu selections.

3. Choose Save Drive Config in the Configure menu. 

A typical operating system SaveAs dialog box opens.

4. Name the new file, specify the target folder, and click Save.

Tip – Use a file name that differentiates it from similar files or overwrite an existing 
file.

The operating system saves the configuration file in the specified location. You can 
retrieve it with the Load Drive Config command button, on page 93.
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▼ To Use the Set Clock Command 
1. Make sure the drive is offline.

If the drive is not offline, set it offline.

Tip – The Configure label must be blue to allow menu selections.

2. Choose Set Clock from the Configure menu. 

The drive internal clock is set to your computer’s clock as shown by a message in the 
transcript pane. 
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▼ To Use the Code Load from Tape Command 

Note – You need a code tape to complete this command (see Make Code Tape in 
TABLE 4-3 on page 74).

The following procedure describes loading code in a T10000 tape drive. The process is 
similar for a T9840D drive but there are some noticeable differences.

1. Make sure the drive is offline.

If the drive is not offline, set it offline.

Note – The Configure label must be blue to allow menu selections.

2. Choose Configure from the menu bar or use the ALT+C shortcut keys to open the 
menu.

3. Choose Code Load from Tape in the Configure menu. 

A text prompt to insert a code load tape appears in the VOP text message pane, and a 
Firmware Update Progress box appears (see below). 

Note – The progress box has a different appearance when loading code in the T9840D 
tape drive.
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4. Insert the code load tape/cartridge containing the proper firmware release level.

The Firmware Update Progress box (below) tracks the update.

When the firmware update is completely loaded into the drive memory, the progress 
box disappears, the code load tape/cartridge unloads, and a prompt to remove the 
code load cartridge appears in the VOP text message pane (see below). 

5. Remove the code load cartridge from the drive load slot.

When the cartridge clears the drive load slot, a drive IPL starts, which will 
load/activate the updated firmware level into the drive RAM.

Note – VOP loses connection to drive during IPL, but automatically reconnects  
after IPL completes successfully.

6. Select Retrieve>Drive Data>Version tab to verify the updated firmware level.

See FIGURE 4-17 “View Current Drive Settings, Version Tab” on page 88
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Help Menu 
The Help menu has a command that displays information about the virtual operator 
panel, the Java version, and the drive connection. 

1. Choose About from the Help menu or use the SHIFT+A shortcut keys. 

The Drive About Dialog box (FIGURE 4-31) lists information about the VOP application 
and, if connected to a drive, it lists the drive name and IP address.

2. Click OK or use the ALT+O shortcut keys to close the dialog box. 

You can also click the X in the upper-right corner of the dialog box.

FIGURE 4-31 About Dialog Box 
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Fault Symptom Code (FSC) Dictionary
VOP version 1.0.15 includes the FSC Dictionary command in the Help menu. You enter 
the four character FSC, select the tape drive model, and click the Lookup button. The 
description of the FSC appears in the transcript pane. The dialog box and transcript 
pane are shown in the following figure. 

Note – The FSC Dictionary is available with or without a drive connection.
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CHAPTER

 

5

VOP Operation - LTO

This chapter provides guidelines for operation of the Virtual Operator Panel (VOP) 
with a single LTO Ultrium generation 4 tape drive. The VOP does not provide any 
interconnection with the host data input/output interface. 

The VOP application window has three basic operational functions:

■ Monitor drive status 
■ View or change drive configuration settings
■ Perform drive service tasks

Use ltoVOP Controls
This ltoVOP graphical user interface (GUI) shown in the figure below provides a menu 
for window control (see FIGURE 1-3 on page 23), the Connect button, a series of status 
indicators, and several tabs. During the course of selected operations, the VOP text 
message pane located on the Service Drive tab displays a transcript of the VOP actions 
and prompts for additional input.

The status indicators show the current drive state. The indicators in the figure above 
have the following meanings: 

■ Online status indicator is dark blue - the Ethernet adapter card is online

■ Empty status indicator is grey - no cartridge is loaded in the drive 

■ Service status indicator is grey - shows that the Ethernet card is communicating with 
the tape drive

FIGURE 5-1 ltoVOP Graphical User Interface



 

Use ltoVOP Controls

118 VOP Customer User’s Guide • December 2009 Revision JB   • 96179

■ Encryption status indicator is grey - the drive is not enrolled

Some status indicators are also an active link that enables you to toggle the state of the 
monitored drive item. Note that the mouse cursor does not change when you place the 
cursor on that type of indicator.

The GUI provides tooltips that appear when you move the cursor to selected areas on 
the window. The figure below shows the tooltip for the first status indicator (Online). 
The tooltip indicates that the tape drive is online. Use a tooltip to display the meaning 
of a status indicator. 

When you load a cartridge in the drive, the cartridge status indicator (the second 
indicator) color changes to dark blue and the label shows Loaded. In addition, the 
Media Type value appears in the Monitor Drive tab (the example below indicates an 
LTO3-formatted cartridge).

VOP to Drive Connection

Note – It is assumed that you have a physical connection between your processing 
platform and the Ethernet port on the tape drive and that you have started VOP (see 
“The ltoVOP Application (Windows)” on page 56 or “The ltoVOP Application 
(Linux/UNIX)” on page 62).

When VOP is not communicating with the tape drive, the IP address is missing from 
the title bar, the Connect button is grey, and the four indicators to the left of the Sun 
logo are black as shown in the figure below. 
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▼ To Connect VOP to the Drive
1. Enter the IP address of the tape drive Ethernet port in the white box beside the 

Connect button.

Tip – The factory sets the address to 10.0.0.1.

2. Click the Connect button.

The IP address appears in the title bar, the Connect button color is blue, the indicator 
color is no longer black, and data appears in the Monitor Drive tab (see the figure 
below). In addition, transcript messages appear in the Service Drive tab (see FIGURE 5-1 
on page 117 for an example). 

Drive Online/Offline Status
To perform some operations from VOP, the drive must be offline. You can use the toggle 
function of the first status indicator or the Set Online/Offline button located in either 
the Enroll Drive or Configure Drive tabs.

▼ To Change Drive Status to Offline
1. Determine the current drive state.

If the drive is Online (see the first status indicator in FIGURE 5-1 on page 117), proceed 
with the next step. If the drive is Offline, stop. 

2. Change the drive state to Offline by using one of the following instructions:

a. Click the first status indicator.

b. Click the Enroll Drive tab and click the Set Offline button.

See FIGURE 5-5 on page 123 for the location of the button.

c. Click the Configure Drive tab and click the Set Offline button.

See FIGURE 5-6 on page 124 for the location of the button.
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3. Verify that the drive status indicator is Offline

The figure below shows that the first status indicator is grey and the label states offline. 
In addition, the button label in the Enroll Drive tab states Set Online.

FIGURE 5-2 Set Online Button
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Error Messages
Certain actions from the GUI result in error conditions. For example, an error occurs if 
you attempt to place the drive (adapter card) offline while a tape cartridge is loaded. 
The following figure shows the resulting error message.

Read and understand the error message before clicking the OK button.

FIGURE 5-3 Error Message
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Monitor Drive
Click the Monitor Drive tab (see the figure below) to display a list of drive, cartridge, 
and Key Management Station agent attributes and values for those attributes. Some 
attributes require another action, such as drive enrollment for encryption, before the 
associated data appears.

FIGURE 5-4 Monitor Drive
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Enroll Drive

Note – Refer to the encryption documentation before using this screen. The sequence 
for using the Configure Drive and Enroll Drive tabs is critical to success.

The Enroll Drive tab contains a Change Enrollment Settings section and four buttons.

Enter a value in the text field to change an enrollment parameter setting. A check mark 
appears in the checkbox to the right of the text field. If you decide against an entered 
change, uncheck the box and the commit operation will ignore that value. 

■ Set Offline - click this button to set the drive offline. 

Note – The label on this button changes depending on the current drive state (Set 
Offline when the drive state is Online or Set Online when the drive state is Offline).

■ Commit - saves the enrollment parameter changes in NV RAM. (The Ethernet card 
does not reboot if you only change the enrollment settings.)

Note – Only those fields with an active check box are updated when you click the 
Commit button.

■ Enroll - performs drive enrollment after committing the enrollment settings.

■ Cancel - clears all pending change selections.

FIGURE 5-5 Enroll Drive



 

Configure Drive

124 VOP Customer User’s Guide • December 2009 Revision JB   • 96179

Configure Drive

Note – Refer to the encryption documentation before using this screen. The sequence 
for using the Configure Drive and Enroll Drive tabs is critical to success.

The Configure Drive panel contains a Change IP Settings section and three buttons.

Enter a value in the text field to change an IP parameter setting. A check mark appears 
in the checkbox to the right of the text field. If you decide against an entered change, 
uncheck the box and the commit operation will ignore that value.

■ Set Offline - click this button to set the tape drive (adapter card) offline. 

Note – The label on this button changes depending on the current drive state (Set 
Offline when the drive state is Online or Set Online when the drive state is Offline).

■ Commit - saves the desired IP change in NV RAM (the Ethernet card does a reboot 
when you change an IP setting).

Note – Only those fields with an active check box are updated when you click the 
Commit button.

■ Cancel - clears all pending change selections.

FIGURE 5-6 Configure Drive
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Service Drive
The Service Drive panel contains a text-based transcript area and seven buttons.

■ Get Support Logs - saves the log files with the name you enter and your specified 
location.

■ Run LED Test - sets the Ethernet card to the LED test mode. The LED flashes when 
you press the drive tray switch (IP Reset on the SL3000 drive tray). See FIGURE 1-4 on 
page 24 for the location of the switch and STATUS LED on an SL3000 drive tray.

■ Clear Transcript - erases the content from the text pane.

■ IPL - performs an initial program load of the Ethernet card.

■ Run Loopback Test - performs an internal loopback test with the LTO-4 drive. Results 
are posted in the text pane.

■ Load Firmware - implements the Ethernet card firmware update procedure. You are 
prompted to identify the directory that contains the Ethernet card firmware files.

■ Adapter Dump - saves the Ethernet card log file with the name you enter and your 
specified location.

Note – Most of the functions on the Service Drive tab are for use by the service 
representative. Refer to the encryption documentation for additional information 
regarding the use of this screen.

FIGURE 5-7 Service Drive
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Changing the Computer IPv4 Address

This appendix provides guidelines to set a static IPv4 address required to connect to the 
drive, and to reset a single Ethernet port for obtaining a dynamic IP address. 

Note – If your computer has two or more Ethernet ports, you can dedicate one for 
static IP addressing and leave the one used to connect to the LAN set for dynamic IP. 

Static IPv4 Address
To connect VOP to a T10000 tape drive that has a static IPv4 address, you must make 
sure your computer has a functional Ethernet port with compatible static IPv4 address.

Note – See your system administrator for Linux/UNIX operating systems.

▼ Setting static IP, Windows OS
Use the following procedure to check or set a static IP address for your computer:

1. Click Start, then select Settings > Network Connections. (FIGURE A-1).

FIGURE A-1 Network Connections Selection
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The Network Connections window (FIGURE A-2) lists all network connections.

2. Double-click the appropriate connection.

The Local Area Connection Properties dialog box (FIGURE A-3) opens.

3. Scroll down, select Internet Protocol (TCP/IP), and click the Properties button. 

The TCP/IP properties dialog box (FIGURE A-4 on page 129) opens.

FIGURE A-2 Network Connections Window

FIGURE A-3 Local Area Connection Dialog Box
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Note – If the port is set for the proper static IP and subnet mask, skip to Step 5. 
Otherwise, perform step 4 to enter/edit the static IP address and subnet mask.

4. Make sure the radio button Use the Following IP Address is selected, then  
enter a compatible static IP address, Subnet mask, and Default gateway.

See your system administrator, as needed for assistance.

Note – Static IP address 10.0.0.2 is typically used for the computer to be compatible 
with a drive factory preset static IP address 10.0.0.1. However, if the drive’s static IP has 
been customized for your site, you must set the computer’s static IP to be compatible 
with the target drive. The first three digit sets must match, and the last digit set must be 
different from the target drive. The last digit set should also be different than any other 
possible target drive on your site.

5. Click OK.

The Local Area Connection Properties dialog box (FIGURE A-3 on page 128) reappears. 

6. Click OK.

You can now connect to any on-site drive that has a compatible static IP address.

FIGURE A-4 Internet Protocol (TCP/IP) Properties Dialog Box
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Dynamic IP Address 
If you set a temporary static IP address for an Ethernet port normally used to connect to 
the LAN, you will need to reset the port to automatically obtain a dynamic IP address. 

▼ Resetting IP to Auto, Windows OS
Use the following procedure to reset a local connection for dynamic IP address: 

1. Click Start, then select Settings > Network Connections (FIGURE A-1 on page 127).

The Network Connections window opens (FIGURE A-2 on page 128).

2. Double-click the Local Area Connection associated with the Ethernet port that 
requires change. 

The Local Area Connection Properties dialog box (FIGURE A-3 on page 128) opens. 

3. Scroll-down, select Internet Protocol (TCP/IP), and click the Properties button. 

You will need to scroll down as TCP/IP is the last selection. The TCP/IP properties 
dialog box (FIGURE A-5) opens.

4. Select Obtain an IP address automatically:

The three IP address fields go blank, and become unavailable for entries.
 

5. Click OK to save the reset.

The Local Area Connection Dialog box (FIGURE A-3 on page 128) reappears. 

6. Click OK.

The Ethernet port is now set to connect to a LAN. 

FIGURE A-5 Internet Protocol (TCP/IP) Properties (auto IP) Dialog Box
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VOP to Drives on Private Networks

This appendix provides supplemental information about VOP to drives connected on 
an IPv4 private network. 

Private Network, SDP-Controlled
When a Service Delivery Platform (SDP) is present, all monitored drives are connected 
into an IPv4 private network, controlled by the SDP site server.

The Ethernet port of every monitored drive is 100% dedicated to the service network, 
and each drive has an SDP-controlled dynamic IP address. Therefore, you do not have 
access to the drive Ethernet port and cannot connect your customer-version VOP to 
such drives.

Note – Only Sun StorageTek service representatives are authorized to access drives 
connected to an SDP-controlled private network. Never disconnect an Ethernet cable 
associated with an SDP-controlled private network.  
 
Contact your Sun StorageTek service representative to change drive configuration 
settings of any drive in the SDP-controlled private network.

However, when an SDP site server is not present, your site personnel can interconnect 
drives from one or more drive cabinets into a non-SDP private network. See “Private 
Network, non-SDP” on page 132.
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Private Network, non-SDP
When an SDP site server is not present, a non-SDP private network (FIGURE B-1), can be 
set up, interconnecting the installed drives to one or more cascaded Ethernet switches. 
Such a network allows you to access any connected drive from a central point.

Overview
In a non-SDP, customer-controlled private network, the Ethernet port of each drive is 
connected to an Ethernet switch. A desktop and/or notebook PC, running the 
customer-version VOP application, would also be connected to the network.

Note – Each connected drive and each computer requires an individual static IP 
address. 

FIGURE B-1 Private Network, non-SDP

1. Desktop PC
2. Notebook PC 

3. Ethernet switch
4. T10000 tape drives
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Components
The following table lists the required components for operating VOP in a non-SDP 
private network.

▼ Setup
Consult with your site IT manager, system administrator, and support personnel to 
install and setup the Ethernet components, and obtain the private network static IP 
addresses. 

Note – Each drive should have been preset at the factory with the following:  
Static IP address: 010.000.000.001 
Subnet mask: 255.255.255.000  
Default gateway: 255.255.255.255 
However, it is a good idea to verify the data using the drive data property sheet for the 
network settings in the Retrieve menu of VOP.

Use the following procedure to set up each drive for the private network.

1. Set your computer static IP address to 10.0.0.2 and the subnet mask to 255.255.255.0.

See “Static IPv4 Address” on page 127.

2. Start VOP

See Chapter 3, “Starting VOP Programs” on page 51.

3. Connect the Ethernet cross-over cable to the computer Ethernet port and to the drive 
Ethernet port.

4. On each installed drive, perform the following steps:

a. Connect VOP to the cabled drive.

See “To Use the Connect to Drive Command”.

b. Reset the drive static IP address to one that is compatible with the new network. 
and commit the change.

See “To Set a Drive Static IPv4 Address” on page 109. 

Component Description

Computer One or more desktop or notebook computers
Note: The computer(s) must use the single-drive, version of the VOP, and 
an Ethernet port configured with a compatible static IPv4 address.

Ethernet switch(es) One or more Ethernet switches might be required to provide a port for each drive, 
one port for each computer, plus additional ports to cascade multiple switches.
Note: See the Ethernet switch vender documentation for setup guidelines. 

Ethernet CAT5 cables One cable for each drive, one cable for each computer, plus additional cables to 
cascade multiple switches with enough length to connect to the switch port and 
allow strain relief.

Ethernet cross-over cable One cross-over cable for direct computer-to-drive connection.
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c. Disconnect the Ethernet cross-over cable from the drive port.

Note – The VOP does not reconnect to the drive following the IPL because the drive 
static IP is no longer 10.0.0.1.

d. Connect a CAT5 Ethernet cable from the open drive port to an available port on 
the Ethernet switch.

If this is the last drive that needs an IP address change, continue with Step 5.

Note – Any drive can be connected to any available Ethernet switch port. It is not 
necessary to assign ports to specific drives. However, you should make a listing of the 
assigned IP address for each drive location.

e. Connect the computer Ethernet cross-over cable to the next drive Ethernet port.

The VOP should automatically connect to the drive because it is still attempting to 
reconnect to IP address 10.0.0.1.

5. Disconnect the cross-over cable from the computer. 

6. Reset the computer static IP address to the private network-designated IP address.

See “Static IPv4 Address” on page 127.

7. Connect a CAT 5 cable to the computer Ethernet port and to an available port on the 
Ethernet switch.

8. Connect VOP to a selected drive.

See “To Use the Connect to Drive Command”.

Tip – Use the private network-designated drive static IP address.

9. Repeat Step 8 for a few different drives.

Note – You only need to enter the other drive’s designated IP address into the Connect 
to Drive dialog box (FIGURE 4-4 on page 68).

The non-SDP private network is now ready for VOP access to any connected drive.
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Glossary

This glossary defines terms and abbreviations in this publication. 

Some of the definitions are taken from other glossaries. The letters in the parentheses 
that follow some definitions indicate the source of the definition:

(A) The American National Standard Dictionary for Information Systems, ANSI X3.172-1990, 
copyright 1990 by the American National Standards Institute (ANSI).

(E) The ANSI/Electronic Industries Association (EIA) Standard-440-A, Fiber Optic 
Terminology.

(I) The Information Technology Vocabulary, developed by Subcommittee 1, Joint Technical 
Committee 1, of the International Organization for Standardization and International 
Electrotechnical Commission (ISO/IEC/JTC1/SC1).

(IBM) The IBM Dictionary of Computing, copyright 1994 by IBM.

(T) Draft international standards committee drafts, and working papers being 
developed by the ISO/IEC/JTC1/SC1.

A
address A character or group of characters that identifies a register, a particular part of 

storage, or some other data source or destination. (A). 

alphanumeric A character or group of characters that identifies a register, a particular part of 
storage, or some other data source or destination. (A).

C
capacity Total amount of User Data stored on one data cartridge in 8 bit bytes. 

Synonymous with “User Capacity” or “Native Capacity”. This is the capacity that 
the user sees after the ECC/Format/ERP etc. overhead has been assessed (no 
compression). 

capacity, raw Total amount of data stored on one data cartridge in 8 bit bytes before any 
ECC/Format/ERP etc. overhead has been assessed (no compression). 
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capacity, user Total amount of data stored on one data cartridge in 8 bit bytes that is sent by 
the host computer. This is the capacity that the user sees after the 
ECC/Format/ERP etc. overhead has been assessed (no compression). 

cartridge A storage device that consists of magnetic tape on supply and takeup reels, in a 
protective housing. (IBM)

cleaning cartridge A data cartridge that contains special material to clean the tape path in a 
transport or drive. 

compress To save space by eliminating gaps, empty fields, redundancy, or unnecessary 
data to shorten the length of records or files. (IBM)

configuration The manner in which the hardware and software of an information processing 
system is organized and interconnected. (T)

connector An electrical or optical part that joins two or more other parts.

D
data cartridge A container holding magnetic tape that can be processed without separating the 

tape from the container. 

data path key management 
(DPKM) The use of the SCSI 4 commands Security Protocol In and Security Protocol Out to 

implement host-based key management encryption on Sun tape drives.

data security erase (DSE) A random binary pattern, over-writing existing data, from the point of an Erase 
command, to the end-of-tape.

data tape A data cartridge formatted for use as a regular data tape for the system in which 
it is used. 

data track(s) The region(s) of recorded tape containing user data formed as discreet 
longitudinal “tracks” (similar to railroad tracks). 

diagnostics Pertaining to the detection and isolation of errors in programs and faults in 
equipment. (IBM)

DPKM See data path key management. 

drive A device for moving magnetic tape and controlling its movement. (IBM)

dump To copy the contents of all or part of virtual storage to collect error information. 
(IBM)

E
emulation The use of programming techniques and special machine features to permit a 

computing system to execute programs written for another system. (IBM)

encryption The translation of data into a secret code. Encryption is one of the most effective 
ways to achieve data security. To read an encrypted file, you must have access to 
a special key or password that enables you to decipher it.
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EOT End of Tape. 

erase To remove data from a data medium, leaving the medium available for 
recording new data. (I) (A) 

error A discrepancy between a computed, observed, or measured value or condition 
and the true, specified, or theoretically correct value or condition. (I) (A)

ESD Electrostatic Discharge. 

F
fault symptom code 

(FSC) A four-character hexadecimal code generated in response to an error to help 
isolate failures within the device. 

FC See fibre channel.

fiber optics The branch of optical technology concerned with the transmission of radiant 
power through fibers made of transparent materials such as glass, fused silica, 
and plastic. (E)

fiber-optic cable A cable made of ultrathin glass or silica fibers which can transmit data using 
pulses of laser light. Fiber-optic cables have several advantages over copper 
cables: they have much less signal loss; they allow information to be transmitted 
at higher speeds and over longer distances; they are not affected by external 
electrical noise; and they are better for transmissions which require security.

fibre channel The National Committee for Information Technology Standards standard that 
defines an ultrahigh-speed, content-independent, multilevel data transmission 
interface that supports multiple protocols simultaneously. Fibre Channel 
supports connectivity to millions of devices over copper and/or fiber-optic 
physical media and provides the best characteristics of both networks and 
channels over diverse topologies.

fibre connection 
(FICON) An ESA/390 and zSeries computer peripheral interface. The I/O interface uses 

ESA/390 and zSeries FICON protocols (FC-FS and FC-SB-2) over a Fibre 
Channel serial interface that configures units attached to a FICON-supported 
Fibre Channel communications fabric.

FICON See fibre connection (FICON). 

FICON channel A channel having a Fibre Channel connection (FICON) channel-to-control-unit 
I/O interface that uses optical cables as a transmission medium. 

file-protect To prevent the erasure or overwriting of data stored on data cartridges.

FIPS Federal Information Processing Standards

FRU Field Replaceable Unit. 

FSC Fault Symptom Code. 

FTP Generic definition: File Transfer Protocol. 
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G
GB See gigabyte (GB).

Gb Gigabit, equal to 109 bits.

Gbps Gigabits per second.

gigabyte (GB) One billion (109) bytes. 

H
hardware All or part of the physical components of an information processing system, 

such as computers or peripheral devices. (T) (A)

hub A Fibre Channel Arbitrated Loop switching device that allows multiple servers 
and targets, such as storage systems, to connect at a central point. A single hub 
configuration appears as a single loop.

I
indicator A device that provides a visual or other indication of the existence of a defined 

state. (T)

interface Hardware, software, or both, that links systems, programs, or devices. (IBM)

internet protocol (IP) A protocol used to route data from its source to its destination in an Internet 
environment. (IBM)

internet protocol (IP) 
address A four-byte value that identifies a device and makes it accessible through a 

network. The format of an IP address is a 32-bit numeric address written as four 
numbers separated by periods. Each number can be from 0 to 255. For example, 
129.80.145.23 could be an IP address.

IP See internet protocol (IP)

internet protocol v4 
(IPv4) address A four-byte value that identifies a device and makes it accessible through a 

network. The format of an IP address is a 32-bit numeric address written as four 
numbers separated by periods. Each number can be from 0 to 255. For example, 
129.80.145.23 could be an IP address. 

internet protocol v6 
(IPv6) address The next generation internet protocol. It provides a much larger address space 

than IPv4. This is based upon the definition of a 128-bit address - IPv4 used a 
32-bit address. The IPv6 address format is eight fields of four hexadecimal 
characters separated by colons (for example, 2001:0db8:85a3:0000:0000:8a2e:037 
0:7334)
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L
library A robotic system that stores, moves, mounts, and dismounts data cartridges that 

are used in data read or write operations.

link A physical connection (electrical or optical) between two nodes of a network.

M
magnetic tape A tape with a magnetizable layer on which data can be stored. (T) 

menu A list of options displayed to the user by a data processing system, from which 
the user can select an action to be initiated. (T)

N
network An arrangement of nodes and branches that connects data processing devices to 

one another through software and hardware links to facilitate information 
interchange.

O
offline Neither controlled by, nor communicating with, a computer. (IBM)

online Pertaining to the operation of a functional unit when under the direct control of 
the computer. (T)

P
performance One of two major factors, together with facility, on which the total productivity 

of a system depends. Performance is largely determined by a combination of 
throughput, response time, and availability. (IBM)

R
read/write head The data sensing and recording unit of a diskette magazine drive or tape drive. 

(IBM)
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release A distribution of a new product or new function and fixes for an existing 
product. (IBM)

R/W Read/Write.

S
SDP Service Delivery Platform. 

submenu A menu related to and reached from a main menu. (IBM)

sub-system A system that is part of some larger system. 

switch In Fibre Channel technology, a device that connects Fibre Channel devices 
together in a fabric.

system A combination of functionally interrelated interacting mechanical and electrical 
elements designed to work as a coherent entity. 

T
tape See magnetic tape. 

tape cartridge A container holding magnetic tape that can be processed without separating the 
tape from the container. 

tape drive A device for moving magnetic tape and controlling its movement. (T)

TCP/IP Transmission Control Protocol/Internet Protocol

transmission control 
protocol/internet protocol 

(TCP/IP) A set of communication protocols that support peer-to-peer connectivity 
functions for both local and wide area networks. (IBM)

V
T10000 Tape Drive

(VOP) A software application that allows a user to monitor and perform some 
operations on a tape drive.

VOLSER VOLume SERial Number. It is, usually 6 characters long and is both the paper 
label stuck on the back edge of the cartridge and in the VOLID label that is 
recorded, particularly by MVS systems, at the beginning of the media. 

volume serial number 
(VOLSER) An alphanumeric label that the host software uses to identify a volume. It 

attaches to the spine of a cartridge and is both human- and machine-readable.

VOP See T10000 Tape Drive (VOP).
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W
wrap A single pass of tape from either BOT to EOT or EOT to BOT with the head(s) in 

a fixed transverse location. 

write-enabled A setting on a data cartridge that allows data to be written on the tape.

write-protected A setting on data cartridges that prevents data from being written on the tape. 
Reading data is still possible.
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dumps to file

command description 77
procedure 89
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dynamic computer address (changing to) 130

E
encrypt tab

change configuration 96
view, T10000 drive 79
view, T9840D 80

enroll
button 123
drive, LTO VOP 123

Ethernet port on a drive tray 24
Ethernet port, drive 65
exit 69

F
fault symptom code dictionary 116
fibre tab

configure T9840D 100
view FCP 81
view FICON 82

file menu
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connect to drive 68
exit 69
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force dump 70, 73
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command 74
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make dump tape 74
rebuild MIR 74
submenu 75

G
get support logs button 125
Glossary 135
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hardware requirements 24
help

about 115
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menu 115
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installation
JRE software 27
VOP software

Linux 41

overview 30
UNIX 41
Windows OS 31

Introduction, VOP 19
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button, ltoVOP 125
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command description 70
procedure 72

J
Java Runtime Environment

download 27
minimum release level requirement 25

JRE 27

K
keyid tab 83

L
language 104
Linux, VOP installation 41
load code from file 113
load drive config, button 94
load firmware button 125
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logs, retrieve to file

command description 77
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application window 22
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adapter dump 125
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operation 117
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service drive 125

M
make

button 75
code tape 74
data tape 74
dump tape 74

manufacturing tab 84
menu

configure 92
drive operations 70
file 67
help 115
retrieve 77

missing tab 85
monitor drive, LTO VOP 122

N
network tab

configure 108
IPv6 static address 108
view 86

O
operating system certification 23
operation

LTO VOP 117
T-series VOP 65

P
perms to file 77, 90
Preface 15
prerequisites 23

hardware 24
Java 25
operating system 23

private networks
overview, non-SDP 132
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T-series VOP

Encrypt 96

R
rear panel Ethernet port 65
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requirements, VOP

hardware 24
Java Runtime Environment 25
operating system 23

retrieve menu 77
picture of 77
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run LED test button 125
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S
save drive configuration 111
service drive, LTO VOP 125
set

clock 112
offline, procedure 71
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online, procedure 71
online, T-series VOP 70

software installation
JRE 27
VOP 30
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computer setting, Windows OS 127
IPv6 108

T
T9840D configure drive settings 100
tape cartridge write-protect switch 76
time

setting clock 112
view, command description 77
view, procedure 89

U
UNIX VOP installation 41
unload tape 70

V
version tab 88
view current drive settings

encrypt tab 79, 80
fibre tab (FCP) 81
fibre tab (FICON) 82
keyid tab 83
manufacturing tab 84
missing tab 85
network tab 86
RFID tab 87
version tab 88

view drive data 77, 78
VOP

application software installation 30
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connect to drive
LTO 119
T-series 68
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installation
Linux/Unix OS 41
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Introduction 19
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configure drive tab 124
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operation
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LTO 117
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